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1. Introduction to Kernel for Outlook Express 

Welcome to the user manual of Kernel for Outlook Express, the most effective and powerful file repair 
software that helps to recover emails from corrupted and damaged dbx files. This user manual will help 
you with the step by step guidelines to use Kernel for Outlook Express software. 

1.1  Using this Manual 

This user manual provides you with the complete understanding of the software usage and its capabilities. 
First time users are advised to read this user manual completely and carefully to gain the full 
understanding of the software before starting with the actual repair procedure with Kernel for Outlook 
Express. 

Beginners should read the user manual completely while an experienced user can use the Table of 
Contents to find out the information pertaining to the tasks that you need to perform with Kernel for 
Outlook Express. 

The table of contents helps you to navigate to different sections of the user manual. The table of contents 
lists all the sections that are contained in this user manual in chronological order. The user manual 
comprises the following sections: 

 Introduction 

 Getting Started 

 Software Interface 

 Repairing .DBX Files 

 Saving Repaired .DBX Files 

 Full Version 

 Support 

 Troubleshooting 

 Legal Notices 

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual. 

1.1.1 List of Abbrevia tions  

DBX: File extension for Outlook Express files 

RAM: Random Access Memory 
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MB: Mega-Byte 

GB: Giga-Byte 

MS: Microsoft 

1.2  About Kernel for Outlook Express 

Kernel for Outlook Express is a result oriented and powerful DBX file repair software to recover emails 
from the corrupt, damaged, inaccessible .DBX files of MS Outlook Express. It successfully recovers emails 
which have become inaccessible due to file corruption or have been deleted permanently from the 
mailbox. 

This software effectively repairs the dbx files of the user profile which is/are configured in Outlook Express 
email client or any other dbx files which are provided by the user for repairing and recovery process. 

It performs powerful and thorough scanning of the corrupt dbx file to cover up all the cases which could 
lead to corruption of your dbx files. This software makes the emails accessible again which become 
inaccessible due to corruption in dbx file header, virus infection, media corruption, accidental deletion etc. 

You might be familiar with the following error messages while trying to open corrupt dbx files of Outlook 
Express. 

 MSIMN caused an invalid page fault in module Msoe.dll 

 MSIMN caused an invalid page fault in module Msoe.dll at address 

 Outlook Express could not be started. It may not be installed correctly. 
Make sure that your disk is not full or that you are not out of memory. 
Contact Microsoft support for further assistance. (0x800c012e) 

 Outlook Express could not be started because Msoe.dll could not be initialized. 
Outlook Express may not be installed correctly. 

 MSIMN caused an exception C0000006h in module Directdb.dll 
The message could not be sent. There is not enough Disk space.  

 Unknown error has occurred. Protocol: SMTP Port: 0 Secure: No [SSL] Error: 0x800c0131 

Kernel for Outlook Express quickly resolves the above listed errors by repairing corrupt .DBX files keeping 
the email format intact. It successfully restores email formatting, email properties (to, from, bcc, date/time), 
email data, attachments, embedded images, background images and all other email objects of the corrupt 
.DBX file. 

Kernel for Outlook Express provides complete and accurate recovery of email components, which ensures 
that the attachments and email properties are associated with the correct email message. 

It is embedded with two saving options: Save in .DBX and Save in .EML, which facilitates its user to save 
the recovered emails in any of the available format. 
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1.3 Salient Features 

Salient features of Kernel for Outlook Express - email recovery software includes: 

 Interactive Graphical User Interface 

 Powerful email recovery engine 

 Powerful file repair engine 

 Support to Unicode language recovery 

 Recovers emails from Outlook Express 5.0, 5.5 and 6.0 .DBX files 

 Recovers emails which have been deleted from the óDeleted Itemsô folder 

 Different saving options to filter the recovered email messages 

 Two saving formats ( .dbx or .eml) to save the recovered email messages 

 Facilitates to select and unselect recovered emails from the preview pane 

 Free demo to analyze capabilities of the tool before purchasing it 

1.4 Who Should Use this Software? 

It is designed for people, who rely on Outlook Express, a simple and user friendly email client for their 
email communication. The efficiency and capability of Kernel for Outlook Express software to repair 
heavily corrupted and damaged files within minutes makes it the best choice for professionals and 
administrators. 

This software is useful for home users, professionals, college users or any other user who were not able to 
perform receiving/sending of emails and also unable to access emails stored in dbx files due to dbx file 
corruption. This corruption could have been caused due to virus attacks, improper system shutdown, 
media corruption where the dbx files are stored, installation of unsupported software, etc. 
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2. Getting Started 

Now that you have understood the features and usefulness of Kernel for Outlook Express, you are ready 
to get hands on experience with the usage of the software. To start repairing dbx files, you will first need to 
download and install the software. 

It is strongly recommended that before installing Kernel for Outlook Express, you should go through the 
installation pre-requisites of the software to ensure that your computer is meeting all the requirements 
required to run the software. 

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for Outlook Express can be broadly classified 
into two major categories ï Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements:  

The hardware requirements for installing the software are as follows: 

 Pentium Class Processor 

 Minimum 64MB RAM (128 MB recommended) 

 10MB for Software installation 

 Disk Space - Enough space to store the repaired files 

@ You should have at-least 10 MB of free disk space if you want to repair and save a 
10 MB .DBX file. 

2.1.2 Software Requirements:  

The software requirements for installing the software can further be grouped into two categoriesï 
Operating system requirements and Outlook Express version requirements. The requirements are as 
follows: 

2.1.2.1 Operating System Requirements  

Supported Operating Systems: 

 Windows Vista 

 Windows 2003 

 Windows 2000 

 Windows XP 
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2.1.2.2 Outlook Express Version Requirements  

Supported Outlook Express versions: 

 Version 5.0, 5.5, 6.0 

2.2 Downloading Kernel for Outlook Express for the First Time 

After checking your computer with the prescribed system requirements for Kernel for Outlook Express, you 
can download and install the software on your computer. You can buy the full version of the software from 
any one of our authorized resellersï Element5, Asknet and 2CO. 

If you want to try using Kernel for Outlook Express before buying it, you can download the evaluation 
version from the following link: 

http://www.nucleustechnologies.com/Download-Outlook-Express-Mails-Recovery-Software.php 

@ You can repair dbx files of the user profile configured on your system or dbx files 
saved on your computer system by using evaluation version of Kernel for Outlook 
Express; however, the evaluation version recovers all the email messages existing 
in the dbx files but will save only 10 emails from each folder of the repaired file. To 
save all the emails, full version needs to be purchased. 

2.3 Install Kernel for Outlook Express 

After downloading the installer file for Kernel for Outlook Express, you can install the software by running 
the file. 

To install Kernel for Outlook Express: 

1. Double-click the Kernel for Outlook Express installer. 

2. Follow the on-screen instructions. 

The Setup Installation Complete screen will be displayed 

3. Click Finish to launch the software. 

2.4 Start Kernel for Outlook Express 

To start Kernel for Outlook Express: 

Click the Start Ą All Programs ĄKernel for Outlook Express 

Alternatively, you can launch Kernel for Outlook Express by double-clicking the shortcut icon available on 
the Desktop and Quick Launch icon. 

2.5 Uninstall Kernel for Outlook Express 

http://www.nucleustechnologies.com/Download-Outlook-Express-Mails-Recovery-Software.php
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You may need to uninstall and re-install Kernel for Outlook Express. To uninstall Kernel for Outlook 
Express: 

1. Click the Start Ą All Programs ĄKernel for Outlook Express Ą Uninstall Kernel for Outlook 
Express 

A warning message will be displayed. 

2. Click óYesô to uninstall Kernel for Outlook Express. 

@ Before proceeding to uninstall Kernel for Outlook Express, you must ensure that the 
software is not running in system background. 

You can alternatively uninstall Kernel for Outlook Express from the Control Panel by performing the 
following steps: 

1. Click the Start Menu Ą Control Panel and then double click the Add or Remove Programs icon. 

2.  Select Kernel for Outlook Express and click Remove. 

A warning message will be displayed. 

3. Click óYesô to uninstall Kernel for Outlook Express. 
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3. Software Interface 

Now that Kernel for Outlook Express has been installed on your computer, you can start using the 
software after getting acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel for Outlook Express comprises two main menus ï File and Help. 

3.1.1 File Menu 

The File menu comprises three menu items. 

 

Figure 3.1: File Menu 

Menu items in the File menu: 

Field Name Field Description 

Open Select to browse and list corrupt .DBX files stored on your hard 
disk 

Save Select to get the Saving Options window to save the recovered 
email items 

Exit Select to close the software 

3.1.2 Help Menu  

The Help menu comprises three menu items. 

 

Figure 3.2: Help Menu 

Menu items in the Help menu: 
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Field Name Field Description 

Software Help Select to view Users Help Manual of Kernel for Outlook 
Express 

Visit Software Homepage Select to visit software homepage 

About Kernel for Outlook 
Express 

Select to view version-related and support information of 
Kernel for Outlook Express 

3.2 Tool-bar 

The tool-bar in Kernel for Outlook Express is displayed below the menu-bar. The tool-bar provides a 
convenient and user-friendly method to perform certain actions that can also be performed by using the 
menu-bar. Read the information in the table below to find out about the tool-bar buttons: 

Button Button Name Button Description 

 

Open Click to launch the "Open" window to select .DBX 
file from your disk drive for email recovery 

 

Save Click to save the recovered email items from 
selected .DBX file(s) 

 

Select All Click to select all items of the selected file 

 

Unselect All Click to unselect all items of the selected file 

 

Help Click to view User's Help Manual of Kernel for 
Outlook Express 
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4. Repairing .DBX Files 

Now that you have complete familiarity of the user interface of Kernel for Outlook Express, you are ready 
to repair .dbx files. 

To repair .dbx files: 

1. Launch Kernel for Outlook Express. By default, software opens up the "Open" window to browse for 
.DBX file. 

 

Figure 4.1: Main Window  

@ Kernel for Outlook Express displays the default user profileôs dbx files which is/are 
configured and listed in Outlook Express. 

2. Browse and list the .DBX file from your disk or select the default listed DBX files from left-hand pane to 
view preview of the respective items. 
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3. Select the folder from which you want to recover email items, software will scan that folder and will 
display recovered items in tree like structure. 

 

Figure 4.2: Recovered Emails 

@ Recovered email items in RED color signify recovery of permanently deleted emails. 

4. Select the appropriate folder for saving and click Save button from toolbar. 
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Figure 4.3: Saving Options Window  

5. Saving Options window appears which asks for the saving option. Select the appropriate one and 
click OK. 
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5. Saving Repaired .DBX Files 

On successful recovery of email items, Kernel for Outlook Express provides with the Saving Options 
window intended to specify the saving options as per the userôs requirements. 

Following saving options are available: 

 Save as DBX: This option saves the selected recovered items in new .DBX file at the defined save 
location. 

 Save as EML: This option saves the selected recovered items in .EML files in a separate folder at 
the defined save location. 

 Save all selected: This option saves all the selected emails. 

 Save all: This option saves every email item which is recovered from corrupt .DBX file / selected 
folder(s) for saving. 

 Save all but deleted: This option saves only those emails which were permanently deleted and 
are now recovered from corrupt .DBX file / selected folder(s) for saving. 

 Save all but existing: This option saves every email which is recovered from corrupt .DBX file / 
selected folder(s) for saving except those emails which were permanently deleted and are now 
recovered. 

The first two saving options define the file format and the location where the recovered emails are allowed 
to save while the last four options are used for the filtration of recovered emails to simplify the saving 
process. 

@ Select any one option from the first two options and then select any one option from 
the last four options. 

 

@ The evaluation version has only Save all option enabled, the rest three are disabled 

(only in evaluation version). 

5.1 Save as DBX 

Perform the following steps to proceed with the saving process. 

1. Select Save as DBX option from the Saving Options window in the software. 
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Figure 5.1 Saving Option  

2. Select the other saving options as per your need: Save all selected, Save all, save all but deleted, 
Save all but existing. 

3. Click OK to continue with the process. 

4. A new window óOutlook Express Folder Selectionô appears to select the Outlook Express folder which 
saves the recovered emails in a sub folder created under the selected folder. 
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Figure 5.2: Select Folder 

5. Then click OK. Software starts the saving process. As soon as Kernel for Outlook Express finishes the 
repairing and saving process, it displays the message ñSaving Process is completeò. 
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Figure 5.3: Saving Process 

6. Recovered emails can be now viewed in Outlook Express under selected main folder. 

5.2 Save as EML 

Follow these steps to save the recovered email items in EML file format. 

1. Select Save as EML option from the Saving Options window. 

 

Figure 5.4 Saving Option- Save as EML 

2. Select the other saving options as per your need: Save all selected, Save all, save all but deleted, 
Save all but existing. 

3. Click OK to continue with the process. 

4. Software displays Browse for Folder window. Here you need to select a location, where the .EML 
files will get saved and click OK to continue with saving process. 
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Figure 5.5: ñBrowse for Folderò Window  

5. Software starts the saving process. As soon as Kernel for Outlook Express finishes the repairing and 
saving process, it displays the message ñSaving process is completeò. 

 

Figure 5.6: Saving Process 

6. Once emails are saved, they can be viewed from the saved location. 
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6. Full Version 

Evaluation version is provided to get acquainted with the features and functions of Kernel for Outlook 
Express. Although you can use Kernel for Outlook Express evaluation version for free and experience the 
capabilities of the software, there are certain limitations in free evaluation version. 

6.1 Requirement of Full Version 

With free evaluation version of Kernel for Outlook Express, you can repair corrupt dbx files; however you 
cannot save the entire recovered emails. Evaluation version allows saving of only first 10 emails from each 
dbx files which have been recovered by the software. 

You will need to buy the full version of the software to save the entire recovered emails. 

6.2 Purchasing Full Version 

You can buy the full version of Kernel for Outlook Express from any one of our authorized resellers ï 
Element5, Asknet and 2CO. 

As soon as the purchase transaction with our resellers gets completed, our sales team will send you an 
email comprising the URL to download the full version of Kernel for Outlook Express and activation details 
of the software. 
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7. Support 

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel for Outlook Express. The software comes with an embedded help manual that can be 
accessed by clicking Help ĄSoftware Help in the menu-bar. You can also press the F1 key on the 
keyboard of your computer to access the embedded help of Kernel for Outlook Express. 

You can access the online help for Kernel for Outlook Express at 
http://www.nucleustechnologies.com/Online-Helps.html 

View Animated Working Demo of the software at 
http://www.nucleustechnologies.com/Animated_Demo_Mails.html 

We also have live support wherein you can chat with our software experts at 
http://www.nucleustechnologies.com/Support.html 

To talk on phone with our software experts call: 

Help line:  
 

+91-9818725861 

1-866-348-7872 (Toll Free for USA/CANADA) 

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

  

http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/Animated_Demo_Mails.html
http://www.nucleustechnologies.com/Support.html
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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8. Troubleshooting 

This section deals with your generic and specific queries pertaining to using Kernel for Outlook Express. 

8.1 Common Issues 

Why does Kernel for Outlook Express have limitations in evaluation copy? 

The free evaluation version of Kernel for Outlook Express enables its users to get acquainted with the 
features and functions of the software before purchasing the full version of the software. Free demo 
version saves only 10 emails from each folder. To save the entire recovered emails, full version needs to 
be purchased. 

8.2 Frequently Asked Questions 

How to Buy Kernel for Outlook Express? 

You can buy Kernel for Outlook Express online at http://www.nucleustechnologies.com/Buy-Outlook-
Express-Mails-Recovery-Software.php 

I have lost my full version for Kernel for Outlook Express. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 

How to identify the deleted emails which are recovered by the software? 

Recovered deleted emails are displayed in RED color for identification. 

What are the supported versions of Outlook Express? 

Kernel for Outlook Express supports repairing of dbx files created with Outlook Express 5.0 and above. 

How much time would be required to repair the corrupt dbx files? 

Repair and recovery time depends on the intensity of the corruption caused to your dbx files. 

Evaluation version does not save all the recovered emails. With free evaluation version, how can I 
know that the software is powerful enough to provide complete and exact recovery of email and its 
associated properties? 

Kernel for Outlook Express is equipped with a view preview before saving feature. With this feature, you 
can analyze the correctness and completeness of your emails and its associated properties before saving. 
In this way, you can check the efficiency of the software before buying its full version. 

  

http://www.nucleustechnologies.com/Buy-Outlook-Express-Mails-Recovery-Software.php
http://www.nucleustechnologies.com/Buy-Outlook-Express-Mails-Recovery-Software.php
mailto:sales@nucleustechnologies.com
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9. Legal Notices 

This section comprises the legal specification about Kernel for Outlook Express and the company 
NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

9.1 Copyright 

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual and 
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights 
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior 
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is 
assumed, however, with respect to the use of the information contained herein. 

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved. 

9.2 Trademark 

Nucleus Kernel ® is a copyright work of Nucleus Data Recovery.Com Private Limited 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista®, MS-DOS and Outlook 
Express are registered trademarks of Microsoft Corporation. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

9.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty 
with regard to this manual or any other information contained herein and here by expressly disclaims any 
implied warranties of merchantability or fitness for any particular purpose with regard to any of the 
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages 
incurred directly or indirectly from any technical or typographical errors or omissions contained herein or 
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary 
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or 
any other information contained herein or the use there of. 

9.4 License Agreement 

Kernel for Outlook Express Copyright © by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM 
PRIVATE LIMITED. The terms and conditions of this License describe the permitted use and users of 
each Licensed Copy of Kernel for Outlook Express. For purposes of this License, if you have a valid 
license, you have the right to use a single Licensed Copy of Nucleus Kernel. 
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Scope of License 

Each Licensed Copy of Kernel for Outlook Express may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All 
rights of any kind in Nucleus Kernel, which are not expressly granted in this License, are entirely and 
exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. You may not rent, 
lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on, 
Nucleus Kernel, nor permit anyone else to do so. You may not make access to Nucleus Kernel available 
to others in connection with a service bureau, application service provider, or similar business, nor permit 
anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for Outlook Express, and any and all accompanying software, files, data and materials, are 
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including Nucleus Kernel, must be thoroughly tested with 
non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of the 
copies of Nucleus Kernel covered by this License. This disclaimer of warranty constitutes an essential part 
of this License. In addition, in no event does NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 
authorize you or anyone else to use Kernel for Outlook Express in applications or systems where Kernel 
for Outlook Express failure to perform can reasonably be expected to result in a significant physical injury, 
or in loss of life. Any such use is entirely at your own risk, and you agree to hold NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED harmless from any and all claims or losses relating to such 
unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein. 

Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by 
you shall not constitute, nor contribute to, a waiver by NUCLEUS DATA RECOVERY.COM PRIVATE 
LIMITED of any other or future violation of the same provision, or any other provision, of this License. 


